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Training, Videos, Documentation and Support
Welcome to JMC.  Your JMC Online Teacher software is a powerful set of tools that will
help you to assess and track student progress in a variety of ways.

This document is one of the various resources available to assist you with using the
Online Teacher software on a daily basis.  JMC also provides a web-based training
opportunities as well as online instructional videos that will help you to understand this
software.  Regardless of your questions, learning style, or experience, JMC provides you
with options to meet your training needs.

Training   JMC offers web-based training and will plan ahead with your staff to
customize these training sessions to efficiently meet your goals. For further information
about training options for your JMC Online Teacher software, please refer to
http://jmcinc.com/resources/training

Videos   JMC offers a wide array of instructional videos that cover common procedures
you will want to know as you progress through the various stages of the school year.
These videos are available on JMC’s website and may be downloaded or viewed anytime.
For a complete list of the videos that are currently available, please refer to
http://jmcinc.com/resources/instructional-videos

Documentation   This document (PDF file) has many sections and may be printed
completely, partially, or not at all.  For example, you may wish to print only the cover
page (which includes the publication date), table of contents, and one section of the
documentation in order to meet a specific need you may have at the time.  Other sections
may be printed at a later point in time as needed.  One potential reason for printing any of
this documentation would be to use it as a companion to a training session or
instructional video.  Once printed, your personal notes may be written on the printed
pages and these pages could be kept in a binder for later review.

Support   JMC offers a variety of technical support options to answer your questions as
they come up.  These options include: asking questions over the phone, setting up remote
technical support sessions, opening web support tickets, and faxing or emailing
documents and questions.  For a complete list of contact options, please refer to
http://jmcinc.com/contact_us

Mentors   Your school district may also have experienced staff (teachers, administrators,
etc.) who are familiar with using the JMC Online Teacher software.  If so, you may find
it convenient to ask questions of these valuable local resources, as well.

JMC Online Teacher Software   In many cases you can find the answers to your
questions by simply reading and using the pages of your JMC Online Teacher software.
The basic features of each page are often self-explanatory, especially for someone who
has used other computerized grade books and/or teacher software.
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JMC Online Teacher Software Overview
JMC Online Teacher software allow teachers to access their student grading data from a
web browser and may be accessed from anywhere you may have internet access such as a
home computer or mobile devices such as an iPad, as well, thereby accessing the same
data that they use while working at school (provided that the school district allows such
access from outside the school building).

JMC Online Teacher software also allows teachers to:
 keep track of student grades on assignments, tests, quizzes, projects, etc.
 calculate and submit term (semester, quarter, trimester, hex) grades
 calculate and submit midterm grades
 create seating charts
 generate progress reports
 generate lesson plans
 submit and view student daily attendance
 submit and view lunch counts
 view student health information
 view student standardized test scores
 view student contact information
 view student demographic data
 send email to students and/or parents

If the school is using JMC’s Online Parent Access module, parents will be able to access
via the Internet various information entered via Online Teacher, such as progress reports,
lesson plans, daily attendance, and term and midterm grades.

Recording Assignment Scores and Calculating Term Grades
The major steps for working with assignment scores and calculating term grades using
the grade book portion of Online Teacher are as follows:

Assignments, Scores, and Term Grades

1. Grade Cutoffs    The teacher’s grade cutoffs must be established before any
scores may be entered for assignments.

2. Categories and Assignments    These can be defined throughout the term.

3. Assignment Scores    These can be entered for defined assignments throughout
the term.

4. Course Grades    Term grades for a course may be calculated at the end of a term
as appropriate.  Also, comments may be included with the term grades.

5. Teacher to Office    Course Grades may be submitted for reporting purposes to
the office using this option.
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Progress Reports

1. Editing Comments    The teacher may establish their own personalized list of
comments that may be included in progress reports.

2. New Progress Reports    The teacher may create a progress report job, which
designates the courses and/or students and the sections and columns to be
included.

3. Editing Progress Reports    The teacher may edit a previously created progress
report job.

4. Printing/Emailing Progress Reports   The teacher may print or email a
previously defined batch of progress reports.

5. Submitting Progress Reports to the Office    Rather than have the teacher print
or email a batch of progress reports, it may be desirable to have the teacher submit
them to the office where they may be printed along with progress reports from all
other teachers.  The office will have a variety of sorting, collating, and other
organizing options that are not available in Online Teacher.

Midterm Reports

1. Generating Midterm Grades     The teacher may generate midterm grades and
comments for their courses.

2. Submitting Midterm Grades    The midterm grades must be submitted to the
office for printing in a report similar to a report card.

Standards and Benchmarks Assessment

1. Instances    Courses and/or Grades must be instanced (enabled) in the office
before a teacher may assess student progress on those standards and/or
benchmarks.

2. Update Teacher’s Data   Office to Teacher (for class list and standards and
benchmarks updates)

3. Calculated Results    For calculated standards and benchmarks results:
a. establish grade cutoffs
b. establish categories and assignments – including benchmark/assignment

links
c. enter assignment scores

4. Weighting of benchmarks within a standard AND/OR assignments within a
benchmark on the Standards and Benchmarks screen.

5. Generate assessments (result sets) using Edit Assessments for a Course or
Grade...  or Edit Assessments for a Student…

6. Teacher to Office to submit assessment sets.
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7. Generate Custom Report Cards    The office staff pulls in assessment sets from
all teachers and generates report cards.

Lesson Plans

1. Creating and Editing    Lesson plans may be created and/or edited by the teacher
by typing, cutting/pasting, or importing from those they created during a prior
school year

2. Printing and Submitting    Lesson plans may me printed or submitted as
required.

Other Information

1. Seating Charts    Teachers may generate seating charts for their courses by
dragging and dropping students onto the classroom grid.

2. Student Demographic Data    Teachers may view some demographic data about
students in their class lists, such as addresses, phone numbers, and email
addresses.  Student demographic data is maintained using the JMC Office
Application.

3. Standardized Test Scores    Teachers may view standardized test score data on
the students in their class lists.  Student standardized test score data is maintained
using the JMC Office Application.
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JMC Software Overview

Your Online Teacher software will help you in assessing student progress in a variety of
ways, but it is just one of several pieces of the puzzle of sharing student information
between teachers, students, parents, administrators, counselors, and various other school
office staff.

Online Teacher    Using JMC Online Teacher you may assess student progress on tests,
quizzes, homework, projects, behaviors, and skills using traditional course grades and/or
standards and benchmarks.  You may also create and share lesson plans, generate seating
charts, view students’ standardized test scores and contact information, and email
students’ primary contacts.

Other Related JMC Software

Online Parent Access    Parents may use JMC Online Parent Access to view
information about their children, such as period attendance, progress reports, lesson
plans, assignment scores, term grades, lunch balances and transactions, contact
information and demographic data.

Office Application    Administrators, counselors, and various office staff may the
JMC Office Application to edit data about students, staff, and school and use this
data to generate various reports such report cards, schedules, transcripts, honor rolls,
activity rosters, lunch balances, health & discipline records, etc.) for school and state
reporting purposes.  Many of the reports in JMC have special options, such as
emailing or exporting to a text file.  Much of the data is automatically available to the
various JMC Online Software modules.

Lunch Point Of Sale    Food service personnel may use the JMC Point of Sale
software to check out students in the lunch line.

Various Other Online Modules    JMC also provides various other online modules,
such as Online Administrator, Online Course Registration, etc.

Support    JMC offers a variety of options for supporting your use of our software.  Our
newly updated website offers training videos and printed documentation as well as news
about software updates and other tips.  And of course you may speak with a technical
support representative during our regular business hours of 8 a.m. to 4:30 p.m. Monday
through Friday throughout the year.

For more information about any JMC software, feel free to contact us at
sales@jmcinc.com or support@jmcinc.com or by calling (800-524-8182) or
faxing (651-345-2215) or by visiting our website (http://www.jmcinc.com).
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Online Teacher Common Tasks
Starting Up Online Teacher
Online Teacher is a web application that can run from within your favorite web browser,
such as Internet Explorer, Firefox, Chrome, Safari, etc.  You should be able to obtain the
web address, or URL, for Online Teacher from your school district’s technical staff or
administrator.  Then simply start your web browser and enter the web address and you
will see a login page similar to the figure below.

Make sure to specify the correct year and building, then enter your username and
password and click the Login button.   You can obtain or reset your username and
password via your school office staff or appropriate administrator.

Updating Class Rosters and Other Data using Office To Teacher Option
You will need to periodically update your student class lists, standards and benchmarks
definitions, grade definitions, etc. for your Online Teacher data. This process is called
Office to Teacher and can be found in the File menu of Online Teacher.

Changing Password
For data privacy and security reasons, Online Teacher is password protected.  For various
reasons, you may wish to periodically change your password.  You may edit your
password after you have logged into Online Teacher by selecting Preferences from the
File menu and then clicking the Edit link to the right of the password.

Submitting Student Data using Teacher to Office Option
Teachers will periodically need to submit data from their Online Teacher software to the
office.  One typical reason for this would be to submit grades at the end of a term.  A
process called

Teacher to Office is used for this purpose.  Teachers may need to submit course grades
and/or standards and benchmarks results to the office for later printing on report cards.

Online Teacher
login screen
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Online Teacher Procedures
Quick Start Guide for Online Teacher
Please Note: Your screen resolution should be 1280X800 or higher.

Setting up Online Teacher and Recording Assignment Scores
1. File Office to Teacher – Updates your class roster. This is done when a student
comes to your class or leaves your class permanently for the year. Please note: this
function also clears out the course comments so this should be done before you start
doing end of term grades.
2. File Preferences – Your password is also listed in the Office.  Set your term.
3. Scores Grade Cutoffs – Follow the directions on the screen.
4. Scores Categories and Assignments – Categories are put in first and then
assignments are listed under those categories.
5. Scores Assignment Scores – Student scores are recorded here.
6. Scores Convert missing to Zero – This function changes every blank, LX, LI, M, and
MI on the assignment scores screen to a zero through the date you list.
7. Edit Seating Charts (Optional)
8. Publish Assignments with the “Publish Assignments” button or in File Publish
Assignments.

Sending Grades to the Office at the End of the Term
9. Edit Course Grades – Right side of screen, Calculate (Current Term) Grades from
Scores... to import the course grade from the assignment scores screen.
10. File Teacher to Office – This function sends grades to the office to be printed.

Progress Reports
11. Reports Progress Reports – This screen creates, edits and prints progress reports.
12. Reports Edit Comments – Edit your progress report comments here.
13. Reports Progress Reports – “Email” Progress Reports – This function emails
progress reports to all primary contacts of your students who have an email address listed
in the office program. After the emails are sent out, a report will be given showing who
was emailed and who wasn’t emailed.
14. Reports Progress Reports - Send Progress Reports “To Office” – This function
sends a progress report to the office. When the office prints out progress reports they are
collated together by student.
15. (Other reports) Missing Score, Class Assignments. Take some time to see the
different reports that Online Teacher offers you.
16. ReportsBlank Score Sheets – This report replaces your paper grade book. 
17. Reports Student Assessment Summary Report and Student Standardized Tests List

Communicating with Parents/Teachers
18. File Send Email Email parents and/or students.
19. Edit Lesson Plans Post course information for parents and students.
20. Homeroom Access View progress reports for students you have in your courses.
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Online Teacher Procedures

Ending the Term - Report Cards with Exam Grades
These directions will show you how to prepare exam grades along with end-of-term
(Semester/Trimester/Year) grades that will be sent to the office and printed on report
cards.

Option # 1
Pros: Very easy to do.
Cons: The program will use the letter grade values from the Office, not the actual
percentage the student earned on the exam.

Step 1:  Go to Edit: Course Grades. Place the cursor under the “Exam” column. Click on
the grade to the right of each student, choose a grade, and it will appear in the box. After
completing the grades for all students , click “Save” and then manually enter the
Semester/Trimester/Year grade or you can calculate them, but they will be calculated
based on the letter grade value not the percentage.
Step 2:  Go to File: Teacher to Office to send grades to the office.

Option #2
Pros: The score/percentage the student earned on the test is used to calculate the
Semester/Trimester/Year grades.
Cons: This option takes longer than Option 1.

Step 1:  Go to File: Preferences. Check the box that says “Include Exams in Course
Menus” and click “Save.”
Step 2:  Go to Scores: Categories and Assignments. Choose the Course with name
“Exam” after it. For example: Language Arts – Per 1 – Sem 1 Exam.

Step 4:  Go to Scores: Assignment Scores, choose the course with which you want to
work that has the name “Exam” at the end and enter the Exam grade for each student.

GradeBook Procedures

Step 3:  Create a category called Exam
and check the “Stand Alone Category”
box. This allows you to enter a score for
this category. If you are grading using
weights put a weight of 100 in for the
category.  If you are grading with total
points there is no need to do this. Click
“Save”

Step 5:  Go to Edit: Course Grades
and choose the course with which
you are working. Go to the Quick
Links on the right side to
Calculate S1/T1 Ex Grades from
Scores, then click OK.
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Ending the Term - Report Cards with No Exam Grades
These directions will show you how to prepare end-of-term (Semester/Trimester/Year)
grades (with no exam grades) that will be sent to the office and printed on report cards.

1. Execute a File: Office to Teacher and then review the Term Grade for each student in
Scores: Assignment Scores.

2. Optional- If you want to give a student a final Term Grade that is different than the
percentage they have earned, you can change it by clicking on that grade for that student
and choosing the grade you wish to give him/her, this is a “locked score”.

3. If a student has a “locked score” but you do not wish them to have one, click on
the check in the box next to the grade to uncheck it. This will change it back to a
calculated grade.

4. Prepare for Grades to be sent to the office by going to Edit: Course Grades.
A. Optional- On the Course Grades screen, verify the weight of each grading term
by clicking on the “Weights…” button.
B. Import your Term Grades from the Assignment Scores screen by going to the
“Quick Links” menu on the far right hand side of your screen and choosing 
“Calculate (the Term you are grading) Grades from Scores.”
C. Optional- Input/Import your Sem/Tri/Year Exam grades if those exam grades
will be printed on report cards.
Please Note: We have a document on the Teachers’ page of our website
explaining the two ways to prepare Sem/Tri/Year Exam grades to be sent to the
office. This document is called “Exam Grades.”

5. If necessary, calculate the Semester/Year Grade from the previous terms by going to
“Quick Links” menu on the far right hand side of your screen and chosing “Calculate
Sem (the Term you are grading)”. Please Note: To calculate a Sem/Tri/Year Grade by
averaging previous grades (ex. Qtr 1 + Qtr 2 = Sem 1 grade) you need to adjust the
weights for the calculation.

A. Stay on (or go to) the Edit: Course Grades screen.
B. Click on the “Weights” button on the Edit: Course Grades screen.
C. Edit the percent weight for each of the term grades used in the calculation.

6. Add comments to each student’s report card by clicking in the “Comment” column.

7. Review the information for the class you are working on and click the “Save” button.

8. Move to the next class by clicking the “Course” pop-up menu button.

9. After all classes have been completed, you must send your grades to the office. Go to
File: Teacher to Office. Click “Execute”.
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9.  (Optional) If you enter in daily assignments
and tie those  assignments to benchmarks to
calculate results, click one of the two
checkboxes that would appear on your screen.  If
you do this you should refer to pages 5-8 of this
document.

10. Click Ok.

Elementary Report Cards – Editing Standards and Benchmarks Results
This is a brief introduction to JMC elementary report cards.  For complete instructions
please visit http://www.jmcinc.com/videos/videos.html and watch the instructional video
“Standards and Benchmarks GradeBook Next-Gen.”
1. Go to File Office to Teacher.  This updates your Online Teacher with any
information that has been updated in the office. There is no need to do this daily.

2. Go to Edit Edit Assessments for a Student if you are a:
• Grade level teacher, i.e. Kindergarten Teacher or 2nd Grade Teacher.
• Specialist teacher, i.e. Art, Music, PE, Computer, etc. who assesses students in

more than one Standard or Benchmark. For example, if you are an Art teacher
who gives an overall course grade and also assesses benchmarks called
“effort” and “works well with other students.”

   Go to Edit Edit Assessments for a Course or Grade if you are a:
• Specialist, Special Ed, or non-grade level teacher who assesses each student in

only one area, i.e. you are the Phy Ed teacher who gives an “effort” grade to
each student.

3.

4. Choose your Grade Level if:
• You are a grade level teacher who has all of the Standards and Benchmarks

instanced to your grade level.
    Choose the Course(s) you teach if:

• You are a specialist, special ed, or other teacher who does not teach all of the
classes a student takes.

• You are a grade level teacher whose Standards and Benchmarks are instanced
to the courses you teach.

5.  (This step is not necessary for most teachers) If necessary, choose your subject area
from the Subject Area pop-up menu.

6. Click on the “Add Assessment Set” button on the top of the screen.

7.

8.

On the top of the screen click on the
“Courses/Grade” pop-up menu.
Choose the course or grade you want
to work with

Choose the Assessment Date per
the instructions on the screen.

If necessary, choose the Assessment Term per the instructions on the screen.

or
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15A. If you have a spot on your report card for “hand-typed”
comments they will be entered only in the comment area for
benchmarks named “Comment Line” or something similar.

11. Start entering assessments and comments (if applicable).  Please refer to the screen
guides below to guide you through this process.

Edit Assessments for a Student Screen
12A. Choose the student you want to assess.

Please Note:  Hand-typed comments can only be placed in areas that have been designed
to display on your report card form.  If you put hand-typed comments into areas that
have not been set up to display those comments, those comments will not display on the
report card forms.

Edit Assessments for a Course or Grade Screen
12B. Choose the Standard.         13B. Choose the Assessment you want to assess.

13A. Click on
the result that
the student has
earned for the
Standard or
Benchmark
where the
cursor is
displayed.

14A. Enter in
hand-typed
results in the
comment area
to the right of
the result box.
For example,
this teacher
hand enters the
result for “Can
count to__.”

14B. The students you
are assessing are listed
on the left -hand side.

15B. Click on the result
that the student has
earned for the Standard
or Benchmark where the
cursor is displayed. For
“hand-typed” comments
refer to 14A and 15A.
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Elementary Report Cards – Editing Course Grades

Preparing Course Grades to Send to the Office   If you enter daily assignment, test,
and project scores into Online Teacher in the Score: Assignment Scores you can have
these Course Grades displayed on the report card if the report card is set up to receive and
display the course grades.  Please note that this section is an abbreviated version of using
Course Grades.  This will be covered in greater detail later in this document.

16. Go to Edit Course Grades.          17. Choose a Course.

Elementary Report Cards – Sending Grades to the Office

19. Go to File Teacher to Office. Make sure
“Standards and Benchmarks” is checked.  If
you entered “Course Grades” (Steps 16-18),
then “Grades” should also be checked.

20. Click Execute.

18. Go to the Quick Links menu and click on “Calculate (The term you are working on)
Grades from Scores…”  A pop-up menu will appear. Click OK.  This will import your
Course Grade from the Assignment Scores screen.

Please Note:  If you need to hand enter any course grades for students you can do so by
simply clicking on the drop down menu where the course grade needs to appear and
choosing the course grade.
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B. Click the
“Benchmarks” button
when you have the
correct assignment
chosen.  This will
bring up a screen
(seen on the next
page) allowing you to
attach that assignment
to a specific
benchmark.

Tying Assignments to Benchmarks to Calculate Results
There are four steps to attach assignments to benchmarks to calculate benchmark results.
The following is a list of those steps followed by a detailed explanation.

 Step 1:  Go to Scores Categories and Assignments to attach Assignments to
Benchmarks.

Step 2:  Go to Scores Standards and Benchmarks to verify Assignment
weighting within a Benchmark.

Step 3:  Go to Edit Edit Assessments for a Course or Grade or Edit Edit
Assessments for a Student to calculate Benchmark results.

Step 4:  Go to File Teacher to Office to send your Standards and Benchmarks to
the office.

Step 1:  Go to Scores Categories and Assignments to attach Assignments to
Benchmarks.

A. To attach assignments to benchmarks, follow the necessary steps to create a
category and then assignments underneath that category. Categories can still be
named Tests, Assignments, Participation, etc. but many teachers find it helpful to
create categories using the names of the benchmarks. That is how it is organized in
this document. Create categories in a way that makes sense to you.

Notes
• If you click the “Benchmarks” button and it tells you
“no benchmark instances have been created for this
course in the office,” you should do an “Office to
Teacher.” If that does not work, the office will have to
instance benchmarks to this course for you.
• Assignments may only be attached to one benchmark.
• You can attach as many assignments to a benchmark as
you would like.
• If you have an assignment/test that applies to more
than one benchmark, you will need to put the parts of the
test in as separate assignments.
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C. Highlight/Choose the benchmark to which you want to attach the assignment and
click “OK.”

D. Now when you highlight/choose an assignment you will see what benchmark is
attached to it.

E. Continue to add assignments and attach them to benchmarks making sure to hit
the “Select a Benchmark” button after you have created an assignment. Your
Categories and Assignments screen may look something like this:
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Step 2:  Go to Scores Standards and Benchmarks to verify assignment weighting
within a Benchmark. This screen will show, in list order, which assignments are attached
to which benchmarks. This screen will also show how the benchmarks are weighted for
calculating a standard.

A. Choose the Course and Standard with which you want to work.

B. If calculating only benchmarks, this screen is used to:
• Review which benchmarks are attached to which assignments.

• Review/change how the assignments are weighted when attached to a benchmark.
Within each benchmark you can set the “Assignment Weights.” By default the
Assignment Weights will be “Equal,” which means each assignment attached to that
benchmark will have equal weight when the benchmark result is calculated. This can
be changed to “By Points,” which means the more points an assignment is worth the
more influence it has when the benchmark is calculated, or to “User Defined.” You
can edit the assignment weighting by clicking here.
C. If you are using this screen to calculate standards, please note the following

items. (Continue on to Step 3 if you are not calculating a standard.)
• Many elementary report cards created in JMC do not print calculated standard

results. They instead print Course Grades (Under Edit Course Grades).  If there
is a question about whether you should calculate Standard results or use a course
grade, you can either go to Edit Edit Assessments for a Student and see if there
is a box in the results column for the standard in question or you can contact your
school’s office professional.
• Each benchmark must have “Weight” designated. By default each weight will be

1 (one) which will make each benchmark equal to the other benchmarks. You can
weight the benchmarks in any way you would like.
• A standard will not calculate unless each benchmark has at least one assignment

attached to it.
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Please note: This screen will look
slightly different on the Edit
Assessments for a Course or
Grade screen.

B. Enter the Assessment date for
the current term.

C. If you want all assignments
(typically not done) to calculate a
Standard, check this box.

D. To calculate the Benchmarks for
all the students in that course, check
this box.

Step 3:  Go to Edit Edit Assessments for a Course or Grade or Edit: Edit
Assessments for a Student to calculate Benchmark results.

A. Choose the course you are working with in the “Course or Grade” pop-up menu
and then click the “Add” or “Add Initial Assessment Set” button in the top right
corner.

E. Click the “Calculate Results” button.

F. The calculated result will appear like the following screen.

G. To recalculate a benchmark and/or standard, click                      .

Calculated Benchmark
Result
This is calculated from the
percentage the student has
earned. The appropriate result
symbol appears here based on
the result cut-offs listed in the
Office program. To change a
result click on it and choose
the new result.

Calculated
Benchmark
Percentage
This is the percentage
taken from the assignment
scores the student
received for assignments
tied to this benchmark.
Remember, the
assignments can be
weighted for a benchmark
in Step 2.

Calculated Standard
Result
If any of the benchmarks
have a calculated result and
you have the option to enter
a standard result, a standard
result will be calculated
from the benchmark
percentages.
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Step 4: Go to File Teacher to Office to send your Standards and Benchmarks to the
office.
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Printing Elementary Report Card Forms
1. Have teachers go to File: Teacher to Office in Online Teacher.  Make sure that

“Grades” and “Standards and Benchmarks” are checked.

2. Bring the Grades into the Office.  Go to Grades Entry GradeBook Entry
choosing the way in which grades are sent to the Office and the term for which
you want to collect grades. Typically schools will bring in both Grades and
Standards and Benchmarks.  Then click Execute.

3. Optional Step: Check to see if teacher(s) successfully sent grades to the office.
Go to Standards and Benchmarks Student Edit Standard and
Benchmark Results.  Go to a student for whom that teacher sent grades.  If that
screen is blank, grades were not correctly sent in.  If there are benchmarks listed
with assessments given, the teacher successfully sent grades to the office.

4. Print report card forms by going to Standards and Benchmarks Reports
Print Standard and Benchmark Transcript.
• One time per gradining term: Choose the term for which you are currently

printing report cards.  In the box labeled Q1/Tri1/Sem End, enter the last day
# for the term.

• Choose who you want to Print. Please note that if you choose to print by
“Advisor” the teacher’s # needs to be put in the “From” and “To” boxes.  The
teacher numbers can be found by going to Attendance Staff Teachers.
The # in front of the teacher name is their number.

• Click the Select Form button and choose the form that corresponds with the
chosen students .

• Optional: Click the “Email if Possible”
box.  This will email all the Primary
Contact who have an email adress and
print a paper copy of the report card for
those who do not when you click the
Print button.

• Click the Print button.
• If nothing shows up on the screen it means that either a student or form was

not chosen correctly.

Please note: A great feature is now available
where the message below will appear on
the Home Page of the JMC Office program
when teachers send grades to the Office.
Click on the message and you will
automatically be taken to the GradeBook
Entry Screen.
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Standards and Benchmarks Troubleshooting Guide
The following is a list of common problems clients may have with Standards and
Benchmarks followed by possible solutions.

Problem 1: A teacher cannot see one, or many, benchmarks on the Edit Edit
Assessment for a Course or Grade or Edit Edit Assessments for a Student screen.

o Cause: The teacher has not performed an “Office to Teacher.”
Notes: Teachers must do an “Office to Teacher” to update their Online Teacher
with the Standards and Benchmarks.
Solution: The teacher needs to do an “Office to Teacher.”

o Cause: The teacher was assigned to new courses (i.e. course #’s) this year.
Notes: To check to see if this is the problem write down the course #’s that pertain
to that teacher.  Next, in the Office Program go to Standards and Benchmarks
Definitions Edit Benchmark Instances. Choose the Hierarchy that will show the
benchmarks the teacher is expecting and see if the appropriate course # is listed.
Solution: In the Office Program go to Standards and Benchmarks Definitions
Edit Benchmark Instances and instance the benchmarks to the new courses.

o Cause: The teacher is not the Advisor for any students.
Notes: All grade level instanced benchmarks are assessed by the Advisor of those
students.
Solution: In the Office Program go to Attendance Staff Assign Advisees,
choose the teacher, choose the grade level of students they teach and assign them
to that teacher.

Problem 2: A teacher has sent standard and benchmark assessments to the office
but they are not showing up on the report card.

Please note: The causes of this problem can be broken into two separate issues. To check
which issue is causing the problem go to Standards and Benchmarks Student Edit
Standard and Benchmark Results and choose a student who is in the teacher’s class.
Consult the following to determine which problem you are having.

Problem 3A: The benchmark results have not yet been received in the Office.  If this is
the problem, the student’s screen will look like the picture below.  If this is the situation
please refer to the Problem 3A section.
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Problem 3B: The benchmark results are in the office but they do not appear on the report
card. If this is the problem, the student’s screen will look something like picture below.
If this is the situation please refer to the Problem 3B section.

Problem 3A Section – No results in the office.

o Cause: The teacher did not enter the benchmark results onto the  Edit Edit
Assessment for a Course or Grade or Edit Edit Assessments for a Student
screens.
Notes: This is more common with teachers who are tying assignments to
benchmarks and do not calculate the benchmark results as is necessary on the
Edit Edit Assessment for a Course or Grade or Edit Edit Assessments for a
Student screens.

o Solution: Have the teacher enter the benchmark results onto the  Edit Edit
Assessment for a Course or Grade or Edit Edit Assessments for a Student
screens. Teachers must then do a “Teacher to Office” and the Standards and
Benchmarks box must be checked. Then the Office must go to Grading Entry
GradeBook Entry and make sure the Standards and Benchmarks box is checked.

o Cause: The teacher did not correctly send their grades to the Office.
Notes: Sometimes teachers do not check “Standards and Benchmarks” or they do
an “Office to Teacher” instead of a “Teacher to Office.”
Solution: Teachers must do a “Teacher to Office” and the Standards and
Benchmarks box must be checked.  Then the Office must go to Grading Entry
GradeBook Entry.

o Cause: The office did not correctly bring the grades into the Office.
Notes: Sometimes when a teacher sends grades to the office for troubleshooting
the office can forget to bring the grades into the office.
Solution: (If not already done: Teachers must do a “Teacher to Office” and the
Standards and Benchmarks box must be checked.) The Office must go to
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Grading Entry GradeBook Entry and make sure the Standards and
Benchmarks box is checked.

Problem 3B Section – Results are in the office but not on the report card.

o Cause: The incorrect Benchmark result box is on the report card.
Notes: To check a benchmark result box on your report card you must have the
JMC Form Designer installed on your computer.  (Please Note: If you do not have
the form designer installed on your computer you must have your technology
professional install it before you can find a solution to this problem.) In the form
designer go to Design Forms: Standard and Benchmark Forms.  Choose the form
you want to work with.  Find the box that is not appearing correctly and double
click on it to see what benchmark is supposed to appear there.
Solution: If you are comfortable editing you Standard and Benchmark forms you
can do so. If you need assistance from a JMC support representative make sure
you have the form designer installed before you call JMC.
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Online Teacher Documentation
File - Preferences
Various aspects of Online Teacher are controlled by settings located on the Preferences
screen.

To edit or view your preferences, select the Preferences option in the File menu.  The
page will appear similar to Figure 1.

Figure 1:
Preferences
for Online
Teacher
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Current Term    You may designate the current term with this menu.

Assignment Scores Page options – Sort Assignments By     Sort options include
Category or Date.

Assignment Scores Page options – Show     Options include All Students or One
Student.

Assignment Scores Page options – Score Colors     For the special grades listed you
may specify the score color to help make them stand out on the Assignment Scores page.

The “Warn if score greater than max score” checkbox will turn on/off warnings about
the score entered exceeding he max score when entering assignment scores.

The “Round Percentages to Determine Grade” checkbox will affect grade calculations.
For example, with this box checked, an 89.9% would be rounded to a 90% to determine
the marking period grade.  On the other hand, if the box were unchecked, an 89.9%
would be considered 89% when determining the marking period grade.

The “Always Use Letter Grades to Calculate Course Grades”, if checked, will not
utilize the percentages when determining the Course Grade.  The program will use the
letter grade values from the Office.

The “Include exams in course menus” checkbox will add semester exam options in
Categories and Assignments for each course section.

The “Show Student Photos” checkbox allows you to specify whether student photos will
be displayed on the Seating Charts and Enter Attendance pages.

The “Allow multiple dates per term in assessment sets” checkbox will allow the
teacher to enter more than one set of assessments per term.

The “Show submitted attendance status” checkbox will show when the teacher has
submitted attendance for a course section (period) on the Enter Attendance page.

To change your password for logging into JMC’s Online Teacher, click the Edit link to
the right of the Password, enter the new password, then click the Update link to save the
change.

File - Office To Teacher
This option is used to periodically update the student class lists, standards and
benchmarks definitions, and student and contact demographic data for your student data.
This does not need to be done the first time you start up Online Teacher.
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File - Teacher To Office
This option is used to submit grades and/or standards and benchmarks assessments to the
office.

1. Select Teacher to Office from the File menu.  The page will appear similar to
Figure 2.

2. If your Online Teacher software is capable of maintaining standards and
benchmarks as well as grades, you will then see a screen similar to Figure 2.  If you
get this screen, specify which type(s) of data to submit to the office, then click OK.

3. Your current grades and comments and/or standards and benchmarks assessments
will be sent to the office.   At a later time, the office staff will pull in this data using a
similar Teacher To Office process.

File - Send Email
This option is used to send email(s) to the student and/or their primary contact(s).  The
email may be edited and sent right from your Online Teacher for any students and/or
primary contacts that have email addresses recorded in the JMC Next Gen Office
Application database.

Note:    Email addresses are not editable in the Online Teacher application.  If you
wish to edit an email address for a student or contact, please forward this
information to the office staff and they will update it in the JMC Next Gen Office
Application database.  Once this is done, the teacher may get the updated email
address in their Online Teacher by doing an Office to Teacher.

1. Select Send Email from the File menu.  The page will appear similar to Figure 3.

Figure 2:

Teacher To Office –
specify which type(s)
of data to send
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2. Specify the course, students within the course, and type of recipients at the top of
the page, then enter the reply-to address, subject, and message and also attach any
documents if needed.  Then click the Send button.

File – Publish Assignments
This option is used to publish assignments to the Online Teacher module for all courses
through the date listed.

1. Select Publish Assignments from the File menu.  The page will appear similar to
Figure 4.

2. Enter the date and click the Publish button.

File – Import Schoology File
This option is import data from a Schoology file.  Once you have the file generated from
Schoology you may import it into JMC using this option.

1. Select Import Schoology File from the File menu.  The page will appear similar
to Figure 5.

Figure 3:

Send Email
page

Figure 4:

Publish Assignments
page
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2. Click Choose File and navigate to the Schoology file you generated at an early
point in time.

3. Click Analyze File to make sure the file is compatible, then click Import
Assignments and Scores to continue.

Edit - Midterm Grades
This option is used to submit midterm grades for a course.  Midterm grades may also be
manually generated using this option, or they may be calculated on the Scores – Edit
Scores screen.

Select Midterm Grades from the Edit menu.  If NO midterm grades have been
calculated for the course and term, the screen will appear similar to Figure 6. If midterm
grades HAVE been calculated for the course and term on the Edit Scores screen, the
screen will appear similar to Figure 7.

Figure 6:
Midterm Grades
page where no
midterm grades
have been
calculated for the
course and term.
Midterm grades
and comments
may be manually
entered on this
screen and then
saved for later
submission.

Figure 5:

Import Schoology
File page
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Once these steps have been completed for as many classes as needed, click Save.  You
may later submit these midterm reports to the office by selecting Teacher to Office from
the File menu.

Edit - Course Grades
This option is used to generate term grades for a course or courses.

1. Select Course Grades under the Edit menu.  The page will appear similar to
Figure 8.

Figure 8:  Course Grades page.

Figure 7:
Midterm Grades
page where
midterm grades
have previously
been calculated for
the course and
term.  Comments
may optionally be
entered in the
Comments column.
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2. Select the desired course/period/term from the pop-up menu at the top of the
window.

3. If you have defined grade cut-offs and have entered assignment scores,  all you
need to do is to go to select Calculate Grades from Scores from the Options
menu.  This action brings the grades from the Assignment Scores screen.  See
Figure 9 for more examples of Calculate Grades from Scores options in the
Options menu of the Course Grades page.

Note:    If you wish to edit the weighting of quarter grades and semester exams in
a semester grade calculation, click on the Weight menu and a screen will appear
similar to Figure 10.  Edit the weights as desired, then click OK.  All
subsequequently calculated semester grades for the selected course will utilize
this new eighting scheme.

4. You may manually enter or edit grades for the students by selecting the course
grade to be edited/entered for the appropriate student and term and then clicking
on the desired grade in the Grades column.

Note:    If you manually change a grade, a checkmark will appear next to the
grade indicating that it is a locked grade.  To unlock the grade click the checkbox,
then the grade will revert back to the calculated grade.

5. Comments may be edited or entered manually for the students by selecting the
comment box to be edited/entered for the appropriate student and clicking on the

Figure 9:

Options Menu for
Course Grades screen

Figure 10:

Editing Weighting for Semester
Grade Calculations
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desired comment on the Comments column on the right-hand side of the screen.

6. Once these steps have been completed for as many classes as needed, click Save.
You may later submit these course grades to the office by selecting Teacher to
Office from the File menu.

Locked / Unlocked Grades   Grades that are calculated using assignment scores are said
to be unlocked.  Scores that are manually entered are said to be locked.  To switch the
locked state of a grade, select the grade and then click the Lock Grade or Unlock Grade
button (the title of the button will change depending up on the locked state of the
currently selected grade).

Print    To print the student grades in the displayed class, click Print.

Edit - Course Weights
This option is used to display the weighting of quarter grades and semeser exams for a
semester for each course in use for a term.  When selected, a screen will appear similar
top Figure 11.

Edit - Calculate All Classes
This option is used to generate term grades for all students in all courses with weights set.
This option will only modify term grades for students if their term grades are unlocked –
in other words, it willl leave manually entered term grades alone but calculate/recalculate
term grades for those that are blank or otherwise unlocked.

Note:   If the grade cutoffs for a course are define differently for the quarters
involved in the calculations, then the resulting semester grades will be calculated
using letter grades and not percentages.  For example, if for a course such as
Music (see Figure 11) the cutoff for an “A” for Quarter 1 is 90 but for Quarter 2
the cutoff for an “A” is 93, then it would be ambiguous as to which cutoff to use
for the semester grade calculation.  An example of the Grade Cutoffs screen is
shown in Figure 49.  In a rare case such as this, the calculation for the semester
grade will use the office’s definition for an “A” (i.e. A = 4.000, B = 3.000… if

Figure
11:
Course
Weights
screen
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your school uses a traditional 4 point scale) for the quarter grade when calculating
a semester grade from the quarter grades.  This same type of substitution may
occur when determining year grades from trimester grades where the grade
cutoffs are defined differently for each trimester.

Edit - Edit Assessments for a Course or Grade
This option is used to edit and maintain standards and benchmarks result sets for a course
or grade.  This option is commonly used for elementary schools that use JMC custom
report card forms, especially for a specialist, special education, or non-grade level teacher
who assesses each student in only one area, i.e. a Physical Education teacher who gives
an “effort” grade to each student.

1. Select Edit Assessments for a Course or Grade… under the Edit menu.  The
screen will appear similar to Figure 12.

Figure 12: Edit Assessments for a Course or Grade page with calculated results.
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Figure 13: Edit Assessments for a Course or Grade screen with manual results.

2. Select the desired course section or grade level from the Course / Grade menu in
the top left corner of the window.

3. Select the desired subject area from the Subject Area menu in the top left corner
of the window.

4. Select the desired standard from the Standard menu in the top left corner of the
window.

5. Select the desired assessment (benchmark or standard) from the Assessment
menu in the top left corner of the window.

Note:    Only standards and/or benchmarks that have been instanced for this
course or grade level will be listed in the Assessment menu.  If you need to
assess a standard and/or benchmark that is not in this menu you will need to
have an instance created for your course or grade level in the JMC Office
Application.  Once this is instanced in the office you may do an Office to
Teacher to update the Standards and Benchmarks definitions in your Online
Teacher.

6. If viewing or editing an existing set of student assessments, select the desired date
from the Assessment Set (date) menu in the top right corner of the window.

Add Assessment Set    To add a new set of student assessments for the currently
specified course or grade level, subject area, standard, and assessment selections,
click the Add Assessment Set button.  You will then be prompted to enter more
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information.  The screen will appear similar to Figure 14.

Note:    A student may have only one record per date and term and standard or
benchmark instance.

Figure 14: Add Assessment Set page for Adding Assessments for a Benchmark.

Assessment Date    Select the assessment date for this new set of results.  If this
is to be a calculated benchmark results set, this date will be used as a cutoff date
for assigment scores. If this is to be a calculated standard results set, this date will
be used as a cutoff date for benchmark results.

The Cumulative – all terms (Standard) button is checked when you want to
calculate a Standard Result based on the cumulative (all previous terms and the
current term) benchmarks.

Note: This can only be used if you have put in assignments and attached them
to benchmarks to calculate benchmark results.

Options for Calculated Results    The Calculate for the currently displayed
benchmark or standard (the benchmark or standard is the listed) button is
checked if you want to calculate only the standard or benchmark results for the
currently displayed benchmark of standard.
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The Calculate all results for the current standard button is checked if you
want to calculate the current standard and benchmarks listed beneath the
specified standard.

The Calculate all results for the current subject area button is checked if
you want to calculate all of the Standards and benchmark beneath the
specified subject area.

Note: These options can only be used if you have put in assignments and
attached them to benchmarks to calculate benchmark results.

Hand-entered Results    To create a set of blank records for the assessment, click
Hand-entered Results.  You may then enter the desired student results
manually.

Calculated Results from Assignment Scores    To create a set of calculated
results for the assessment, click Calculated Results from Assignment Scores.  If
currently calculating a standard result, a screen similar to Figure 15 will appear
with a summary of the calculation that is about to happen.

Note:    Standards calculations option: When calculating a standard result, a
Cumulative – All Terms checkbox is enabled on the Add a New Assessment
Set screen (see Figure 14).  This option affects whether standard assessment
calculations are to use benchmark results from all terms or from the currently
selected term.

Note:    Weighting for Standard or Benchmark Results Calculations may
be edited by selecting Standards and Benchmarks… from the Scores menu.

Note:    Benchmark Results are calculated based upon the current scores for
assignments that have been attached to a benchmark in your Online Teacher.
Assignments may be attached to a benchmark by selecting Categories and
Assignments from the Scores menu and clicking the Select Benchmark
button for the appropriate assignment(s).

Note:    After a result set is calculated, some students’ results may be a box
with no result or percentage.  In these cases, a result could not be calculated.
If this is a standard assessment, this may be due to the student having a locked
(non-calculated) result for one of their most recent benchmark results or they
may have no benchmark results at all to use for this calculation; therefore,
there is not enough information to calculate the result.  If this is a benchmark
assessment, this may be due to the student not having any assignment scores
on which to base a benchmark result calculation.

Note:    Result symbols (e.g. HP, PR, NP, etc.) and cutoffs (90% or better for
an HP, etc.) are established in the office for each subject area.  You will not be
allowed to enter a result manually that is not defined in the office for the
specified subject area.
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Delete Assessment Set    To delete the currently displayed assessment (set of results),
click the Delete Assessment Set button.  Deleting of a result set will cause them to be
deleted in the office database the next time the teacher submits standards and
benchmarks results to the office via Teacher to Office.

Locked Results    To give a student a result other than the calculated result, enter the
desired result for the student by selecting the result and then editing it.  A check mark
will appear in the lock column indicating that it is a locked result and the result
percentage will no longer be dislpayed.  If the result is then unlocked, the result
percentage will have been set to zero and the corresponding result will be set
accordingly.

Edit - Edit Assessments for a Student
This option is used to edit and maintain standards and benchmarks result sets for a course
or grade.  This option is commonly used for elementary schools that use JMC custom
report card forms, especially for a grade level teacher such as a Kindergarten or 2nd grade
teacher or a specialist teacher such as an art, music, physical education, or computer
teacher who assesses students in more than one standard or benchmark.  An example of
such a specialist teacher would be an art teacher who gives an overall course grade and
also assesses benchmarks called “effort” and “works well with other students.”

1. Select Edit Assessments for a Student… under the Edit menu.  A screen will
appear similar to Figure 15.

Figure 15: Edit Assessments for a Student screen – first time.

2. Select the desired course section or grade level from the Course / Grade menu in
the top left corner of the screen.

3. Select the desired subject area from the Subject Area menu in the top left corner
of the window.

4. Select the desired standard from the Standard menu in the top left corner of the
window.

5. Select the desired student from the Student menu in the top left corner of the
window.
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6. If viewing or editing an existing set of student assessments, select the desired date
from the Assessment Set menu in the top right corner of the window.

Add Assessment Set    To add a new set of assessments for the currently specified
course or grade, subject area, standard, and student, click Add Assessment Set.  You
will then be prompted to enter more information with a window that will appear
similar to Figure 16.

Figure 16: Add Assessment Set for a Student.

Note:    A student may have only one record per date and term and standard or
benchmark instance.

Assessment Date    Enter the assessment date for this new set of results.  If this is to
be a calculated benchmark results set, this date will be used as a cutoff date for
assignment scores. If this is to be a calculated standard results set, this date will be
used as a cutoff date for benchmark results.

Cumulative – all terms (Standard)    The Cumulative – all terms (Standard)
button is checked when you want to calculate a Standard Result based on the
cumulative (all previous terms and the current term) benchmarks.
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Note: This can only be used if you have put in assignments and attached them to
benchmarks to calculate benchmark results.

Calculate for all students in this Course or Grade    The Calculate for all
students in this Course or Grade button is checked if you want to calculate the
benchmark results for all the students in the course not just the student who was
currently displayed when you added the assessment set.

Note: This can only be used if you have put in assignments and attached them to
benchmarks to calculate benchmark results.

Click the Ok button to create the assessment set.

Hand-entered Results    To create a set of blank records for the student, click Hand-
entered Results.  You may then enter the desired student results manually.

Calculate Results from Assignment Scores    To create a set of calculated results
for the assessment, click Calculate Results from Assignment Scores.

Standards calculations option: If the currently specified standard is instanced for
the selected course or grade level, a Cumulative – All Terms checkbox is enabled on
the Add Assessment Set screen (see Figure 16).  This option affects whether standard
assessment calculations are to use benchmark results from all terms or from the
currently selected term.

Note:    Standard Results are calculated based upon benchmark assessments that
pertain to this standard for the class that are as of the date specified for the assessment
set currently being created.  They are NOT based on stored benchmark assessments
like they would be if they were created on the Edit Assessments for a Course or
Grade screen.

Note:    Benchmark Results are calculated based upon the current scores for
assignments that have been attached to a benchmark in your Online Teacher.
Assignments may be attached to a benchmark by selecting Categories and
Assignments from the Scores menu and clicking the Select Benchmark button for
the appropriate assignment(s).

Note:    Weighting for Standard or Benchmark Results Calculations may be
edited by selecting Standards and Benchmarks… from the Scores menu.

Note:    After an assessmentset is calculated, some students’ results may be a box
with no result or percentage.  In these cases, a result could not be calculated.  If this is
a standard assessment, this may be due to the student having a locked (non-
calculated) result for one of the currently calculated benchmark results; therefore,
there is not enough information to calculate the result.  If this is a benchmark
assessment, this may be due to the student not having any assignment scores on
which to base a benchmark result calculation.

Note:    Result symbols (e.g. HP, PR, NP, etc.) and cutoffs (90% or better for an HP,
etc.) are established in the office for each subject area.  You will not be allowed to
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enter a result manually that is not defined in the office for the specified subject area.

Figure 17: Edit Assessments for a Student with an Assessment Set Added

Delete Assessment Set    To delete an assessment set, click Delete Assessment Set.  A
screen will appear similar to Figure 18.  Deleting of a result set will cause them to be
deleted in the office database the next time the teacher submits standards and benchmarks
results to the office via Teacher to Office.

Figure 18: Deleting an Assessment Set
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Edit - Edit Assessments Report Card for a Student
This option is used to edit and maintain standards and benchmarks result sets for a
student using a custom-designed form as the template for entering grades.  This option is
commonly used for elementary schools that use JMC custom report card forms.

1. Select Edit Assessments Report Card for a Student… under the Edit menu.  The
screen will appear similar to Figure 19.

Figure 19: Edit Assessments Report Card for a Student page.

2. Select the desired course section or grade level from the Course / Grade menu in the
top left corner of the window.

3. Select the desired subject area from the Subject Area menu in the top left corner of
the window.

4. If viewing or editing an existing set of student assessments, select the desired date
from the Assessment Set (date) menu in the top right corner of the window.

Add Assessment Set    To add a new set of student assessments for the currently
specified course or grade level, subject area, standard, and assessment selections,
click the Add Assessment Set button.  You will then be prompted to enter more
information.  The screen will appear similar to Figure 20.

Note:    A student may have only one record per date and term and standard or
benchmark instance.
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Assessment Date    Select the assessment date for this new set of results.  If this is to be a
calculated benchmark results set, this date will be used as a cutoff date for assignment
scores. If this is to be a calculated standard results set, this date will be used as a cutoff
date for benchmark results.

Assessment Term    Select the term for this new set of results.

Figure 20:

Add
Assessment Set
page for
Adding
Assessments
for a
Benchmark.
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Edit - Seating Charts
This option is used to edit and print seating charts.

Under the Edit menu, select Seating Charts.  A screen will appear similar to Figure 21.

Figure 21: Edit Seating Charts page

Course Menu    To view or edit seating charts for a different class, select the correct
period and course from the Course menu.

Adding Students to the Chart    To add a student to the seating chart, drag the student
from the students list on the left side of the screen to the seating chart.

Removing Students from the Chart    To remove a student to the seating chart, drag the
student off of the chart.  Once the student has been removed from the seating chart, a
check mark will disappear next to their name in the student list.

Random    To randomly change the order of an existing seating chart, click Random.
This option will only shuffle students that are already placed in the seating chart and will
only place them into positions that are already designated in the seating chart.

Clear To clear the selected seating chart, click Clear.

Print    To print the currently displayed seating chart, click Print.
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Edit - Seating Charts (older version)
This option is used to edit and print seating charts.

1. Under the Edit menu, select Seating Charts (older version).  A screen will appear
similar to Figure 22.

Figure 22: Edit Seating Charts (older version)

Course Menu    To view or edit seating charts for a different class, select the correct
period and course from the Course menu.

Dimension Menu     To specify the dimension of the seating chart grid, select the option
that best fits the class from the Dimension drop down list.

Adding Students to the Chart    To add a student to the seating chart, select the student
from the drop down list for that cell.

Removing Students from the Chart   To remove a student to the seating chart, select
the “blank” student from the top of the drop down list for that cell.

Clear To clear the selected seating chart, click Clear.
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Print    To print the currently displayed seating chart, click Print.

Save    To save changes for the currently displayed seating chart, click Save.

Edit - Edit Lesson Plans
This option is used to edit and print lesson plans.

1. Under the Edit menu, select Lesson Plans. The page will appear similar to Figure
23 with a list of courses that are in the currently selected term in the upper left
corner as well as a list of dates for which the selected course already has lesson
plans.

Figure 23: Edit Lesson Plans page.

New    To add a new lesson plan for this course, click New…  You will then be
prompted to specify the date for the new lesson plan.  After the date is entered, a
screen will appear similar to Figure 24.  On this screen, type in the lesson plan as
desired.  Click OK to save the lesson plan.

Figure 24:

Editing a Lesson Plan
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Edit    To edit an existing lesson plan, select the lesson plan from the list similar to
Figure 23, then click Edit…  A screen similar to Figure 24 will appear.  Make the
desired edits, then click OK to save the changes.

Delete    To delete an existing lesson plan, select the lesson plan from the list similar
to Figure 23, then click Delete…  A screen will then appear asking you to confirm the
deletion.

Print    To print one or more lesson plans for the currently specified course, click
Print…  A screen will appear similar to Figure 25.  Specify the range of dates to be
printed and click Preview.  Then click Print when you are ready to print the
previewed lesson plans.

Copy… To copy the currently selected lesson plan to other courses, click Copy…  The
page will appear similar to Figure 26.  Specify the courses that are to receive a copy of
the lesson plan and click OK.  After a short delay, a message will be displayed stating
that the lesson plan was successfully copied to the specified course(s).

Figure 25:

Printing
Lesson Plans

Figure 26:

Copying Lesson
Plans to Other
Courses
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Edit - Import Lesson Plans from Prior Year
This option is used to import lesson plans from a prior year as well as edit, save and print
lesson plans and copy lesson plans to other courses.

1. Under the Edit menu, select Import Lesson Plans from Prior Year.  The page will
appear similar to Figure 27 with a list of dates for the currently specified course and
term for the current year on the right side of the screen.

2. Select a course from the Course menu for the current year for which you wish to
import or edit lesson plans.  This course will be referred to as the destination course.

Note:    If the course for which you wish to edit lesson plans is not in the list, you may
need to select a different term from the Current Term menu on File – Preferences.

Figure 27: Import Lesson Plans from Prior Year  - initial state

3. The left side of the page will display the available lesson plans from the source
course for the prior year.  Select a course from the Course menu for the prior year.
You may first need to switch the teacher number in the Teacher menu in the upper
left corner.  Then click on the date of the lesson plan you wish to import.  The lesson
plan selected will automatically display in the middle of the page as in Figure 28.
Also, the date for the imported lesson plan will automatically be set to the same date
but one year later.  You may wish to edit the date as appropriate.
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Figure 28: Import Lesson Plans from Prior Year  - with imported text

Save    To save the text from the Lesson Plan Text box to a lesson plan for the current
year, click Save.  The imported lesson plan will then be listed in the list of lesson plans
for the current year.

Edit…    To edit an existing lesson plan, select the lesson plan from the current year list,
then click Edit...  The text for that lesson plan will then appear in the Lesson Plan Text
box.  Make the desired edits, then click OK to save the changes.

Delete…    To delete an existing lesson plan, select the lesson plan from the the current
year list, then click Delete…  A screen will then appear asking you to confirm the
deletion.

Copy… To copy the currently selected lesson plan to other courses, click Copy…  The
page will appear similar to Figure 29.  Specify the courses that are to receive a copy of
the lesson plan and click OK.  After a short delay, a message will be displayed stating
that the lesson plan was successfully copied to the specified course(s).

Figure 29:

Copying Lesson Plans
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Edit – Student Sort
This option is used to change the sort order of the students in a class list.

1. Under the Edit menu, select Student Sort.  The page will appear similar to Figure
30.

Figure 30: Student Sort

2. Select a course from the Courses menu for which you wish to modify the sort order
of the student list.

You may either choose to

Sort Active Students Alphabetically, then Inactive Students
or
Sort All Students Alphabetically
or
use the up and down arrows on the left of the page to manually move students up
and/or down in the list.
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Scores - Assignment Scores
This option is used to enter and edit student assignment scores.  Midterm grades may also
be calculated with this option.

Note:    Prior to entering scores for individual student scores, the assignments must
already be defined using Scores – Categories and Assignments and also the grade
cutoffs must already be defined using Scores – Grade Cutoffs.

1. Select Assignment Scores from the Scores menu.  The screen will appear similar to
Figure 31.

Figure 31; Assignment Scores page

The columns may be sorted by date or category – see Figure 33.  When sorting by date,
be sure a date has been entered for each assignment on the Categories and Assignments
screen in the Scores menu.

Showing One/All Students

It may be preferable at times to show only one student row on the Edit Scores screen.
An example where this may be useful is if you want to show assignment scores to
parents during a conference and want to hide all other students’ grades for data
privacy purposes.  To do so, select the Show One Student option from the Quick
Links (see Figure 32), then arrow up or down to the desired student.  The page will
appear similar to Figure 32.
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Figure 32: Assignment Scores screen with Show One Student option

To revert to displaying assignment scores for all students, select the Show All
Students option from the Quick Links.

Assignment Scores Preferences

To change this sort citerion, select the approriate option from File - Preferences as
shown in Figure 33.

Sort sssignments by   The columns may be sorted by date or category.  When sorting
by date, be sure a date has been entered for each assignment.

Show   Option to either show all or one stdent on various pages.

Score Colors   Special coloring for various score types may be specified here.

Figure 33:

Preferences for
Assignment Score
Screen
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Editing Student Assignment Scores

- To select a cell (the intersection of a student’s row and an assignment column) in
the scores list, either click on the desired cell or use the keyboard to move the
selection rectangle to the cell.

Note:    Under Edit you may select Cut/Copy/Paste or use keyboard shortcuts.

Note:    Use scroll bars or movement keys to bring the desired
student/assignment into view.

Down = <Return>, <Enter> or <Down-Arrow>
Movement Keys: Up = <Up-Arrow>

Left = <Shift-Tab>
Right = <Tab>

- To enter a score, select the cell for the student in the correct column and type the
score.  Scores may be entered with one decimal place.

- To enter another score, press one of the movement keys or click the desired cell
and type the score.

- Once the first score in the column has been entered, you may fill the score down
for all students by selecting Fill Score Column from the Options menu.

Score-Exemption and Non-Scores:
- A “.” (period) in a column means that a score has not yet been entered for the

student.

- A score of 0 (zero) in a column indicates that the student has received no credit
for the assignment.

- An “X” in a column means that the student is exempt from the assignment.

Late Assignments:
- Late Included—“LI”- By entering an “LI” on the Assignment Scores page for an

assignment, the computer will be including the late assignment as a ZERO.

- Late Exempt—“LX”- By entering an “LX” on the Assignment Scores page for
an assignment, the computer will NOT include the late assignment in calculations.

Note:    An “LX” or “LI” is considered a missing score. Convert Missing
Scores to Zero and the Missing Scores Report will treat the “LX” and “LI” as
missing scores.

Missing Assignments:
- Missing Included—“MI”- By entering an “MI” on the Assignment Scores page

for an assignment, the computer will be including the late assignment as a ZERO.

- Missing Exempt—“MX”- By entering an “MX” on the Assignment Scores page
for an assignment, the computer will NOT include the late assignment in
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calculations.

Handed In:
- Handed In Exempt—“HI”- By entering an “HI” on the Assignment Scores page

for an assignment, the computer will NOT include the late assignment in
calculations but notes that the student did hand in the assignment.

Assignment Note    You can attach a free-hand comment to any assignment score.  To
edit/enter a note: hold down the Option key while clicking on the desired assignment
score OR highlight the score by clicking or using the Movement keys and then once the
desired assignment is highlighted, go under the Options menu to Edit Score Note.  The
page will appear similar to Figure 34.

Once the note has been entered, select either All Students or This Student to designate
which students will have this score note attached to their score.  An assignment score that
has a note attached to it will display an “*” to the right of the score.  The Score Note will
print on Student Summaries and Progress Reports.

Student Info - Demographic Data    To view demographic data (address, phone
numbers, etc.) for a student, click on the Info icon next to the student.  See Figure 35.

  Figure 35:  Student Info icon for Assignment Scores screen.

After clicking on the Info icon, a screen will appear similar to Figure 36.  This data is for
display only and cannot be edited from Online Teacher.  To have this data edited, submit
demographic data changes to the office staff and they will make the appropriate edits in
the JMC Office Application.

Figure 34:

Editing a Score
Note
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Print Student    Click Print Student to print a Student Summary Report for the
currently selected student only.  The report shows all of the scores for the student along
with the student’s current grade and percentage.  This report may also be obtained by
double-clicking a student name.

Locked Grades    To override a calculated grade, manually select the desired grade from
the drop down list.  The check box to the right of that grade will be checked, which
denotes that the grade is locked and is not the result of a calculation.  To revert to the
calculated grade, uncheck the check box to the right of that grade.

Filling Score Column    To fill down (copy) the selected score to all students for an
assignment, select the desired score and then select Fill Score Column from the Quick
Links.

Import Student Scores from Prior Section    When a student is moved from one section
to another, the student’s assignment scores will appear at the bottom of the list for their
prior section and will be grayed out.

Note:    Import Student Scores from Prior Section will only work if the prior
and new sections have exactly the same categories and assignments as well as
grade cutoffs.

To import these scores to the student’s new section:

1. Select the new section from the Course menu at the top of the screen.

Figure 36:

Student
Demographic
Data for  Online
Teacher.
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2. Select Import Student Scores from Prior Section from the Options menu.

Remove Inactive Student Permanently    Once a students scores have been imported
from a prior section, or if a student is no longer enrolled in a course, you may wish to
remove the inactive student permanently by first selecting the inactive student and then
selecting Remove Inactive Student Permanently from the Quick Links.

Student Sort     To change the sort order of the students in  a class list, select Student
Sort from the Quick Links.  The page will appear similar to Figure 37.

Select a course from the Courses menu for which you wish to modify the sort order
of the student list.

You may either choose to

Sort Active Students Alphabetically, then Inactive Students
or
Sort All Students Alphabetically
or
use the up and down arrows on the left of the page to manually move students up
and/or down in the list.

Note:    As a student gets rescheduled into a different section, they will by default be
listed in alphabetical order in their new section in Online Teacher.  Sometimes you
may wish to have them listed differently, such as at at the bottom of the list.  This
may be desirable if you are recording scores on a paper list prior to entering them into
Online Teacher, in which case the student that is new to this section would likely get

Figure 37:

Student Sort
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added to the bottom of the paper list and not inserted alphabetically.

Midterm or other In-Progress Grades    Online Teacher allows midterm or other “in-
progress” grades to be captured and transferred to the office.  These “in-progress” grades
can be used by the office for midterm report cards or eligibility checking.

To calculate midterm or other “in-progress” grades:

1. By default, in the upper left corner of the Assignment Scores page under the
term, the word Current will appear.

2. Click on the drop down list displaying Current and select Midterm.  A box will
appear with the word Date.

3. Enter the midterm date and press Enter.  Assignments through this date will be
included in the Midterm/In-Progress calculation, which will be displayed on the
column at the far right side of the screen.  See Figure 38.

Figure 38: Calculating Midterm Grades using Scores – Assignment Scores

To edit midterm or “in-progress” grades:
Midterm or “In-progress” grades may be edited:

- on the Assignment Scores screen
OR

- by selecting Midterm Grades under the Edit menu on the main window.

To override a calculated midterm or “in-progress” grade:
1. Click on the grade and select the desired grade from the pop-up menu.

2. When you release, a box will appear around the student’s grade, informing you
that the grade is locked and is not the result of calculations.

To return to the calculated grade, click on the locked grade and select Calculated
from the pop-up menu.
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Scores - Categories and Assignments
This option is used for defining your assignments and the categories to which those
assignments belong.  For example:  A category named Tests may be defined which
consists of individual tests, referred to as assignments.

Note:    Links in the upper right corner of this page (not Quick Links) as well as the
fields displayed on the right side of the page will vary depending upon which
category or assignment is selected (if any) or if a course has been selected from the
Course drop down list and whether a course will have grades calculated by weight or
total points.  To select a category or assignment, click on its name in the list on the
left side of the page.  The will appear similar to one of the following Figures (39a,
39b, or 39c).

Figure 39a: Categories and Assignments page.

Figure 39b: Categories and Assignments page – Category Selected.
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Figure 39c: Categories and Assignments page – Assignment Selected.

Note:    Most of the Quick Links at the far right side of the page are links to
Instructional Videos on how to do specific tasks on this page.

Calculate Using    The overall weighting of your catego ries may be by individual
category weights or total points.  If Total Points is selected, all calculations are based
simply on the number of points.  If you select Weights, then you MUST enter a weight
for each category.

Import…    To impoprt categories and assignments from a prior year’s course, click the
Import… button.  The page will appear similar to Figure 40a.  Select the course from the
prior year on the left side and also select the categories and assignments you wish to
import from that course.  Then select the course from the current year on the right side of
the page, then click the Import button in the middle of the page.

Note:    To import Categories and Assignments from a current year’s course, use the
Quick Link at the far right side of the page called Import Categories, Assignments,
and Scores from Current Year.
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Figure 40a: Import Categories and Assignments from a Prior Year’s Course

Figure 40b: Import Categories and Assignments from a Prior Year’s Course with All
Categories and Assignments Selected from Prior Year Course, also Course Selected for

Current Year
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Figure 40c: Import Categories and Assignments from a Prior Year’s Course After Import

Copy…    To copy categories and assignments from the current class to other classes in
the current year, click the Copy… button.  The page will apear similar to Figure 41.
Then select the categories and assignments to be copied from the left list and then select
the courses to receive the copies in the right list, then click Save.

Adding Categories    To add a category to the currently selected course, click on the
Add Category link in the upper right corner.  Fields for the new category will appear on

Figure 41:

Copying
Categories and
Assignments
from the
Current
Course to
Other Courses
in the Current
Year
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the right side of the page, as shown in Figure 42a (using Total Points) or 42b (using
Weights). In the upper-right, enter the name of the Category and other pertinent details
about that category (stand-alone, extra credit, low scores to drop, sort order for the
category).

Note:    Enter only categories for the current marking period.

Figure 42a:  Adding a Category for a Course – Total Points

Figure 42b:  Newly Added Category for a Course – Weights

Category Characteristics
To set the characteristics of a category, click on the category name.  The current settings
are displayed on the right.

Weight:  Refers to the amount the category average counts towards the overall grade.

Note:  Category weights DO NOT have to total 100%.

Assignment Weights:  Displays how the assignments are being weighted towards the
category average.  Assignments may be weighted in these ways:

- Equally – the assignments will each count the same towards the category
average.

- By Points – the weight of each assignment towards the category average
is based on the number of points the assignment is worth.

- User-Defined – you will enter the assignment’s weight towards the
category average by clicking on the assignment name.  A weight box will
appear to the right.

# of Low Scores to Drop: Allows you to define the number of low scores in the
category to be dropped from the student’s grade calculation.
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Stand-Alone category: By “X”ing this box, the category percentage will be
composed entirely of one score.  A Max Score must be entered which represents the
total points possible for the category.

Extra-Credit category: If checked, the category and any assignments in that
category count for extra credit.  No penalty will be given for missing an extra-credit
score.  You may define more than one extra-credit category.

Adding Assignments    To add an assignment to the currently selected course and
category, click on the Add Assignment link in the upper right corner.  Fields for the new
assignment will appear on the right side of the page, as shown in Figure 43. In the upper-
right, enter the name of the assignment and other pertinent details about that assignment
(max score, date, weight, benchmark, sort order for the assignment).

Figure 43: Adding an Assignment to a Category for a Course

Max Score:  Edits the maximum possible assignment score or stand-alone
category score.  

Note:    Scores may be entered to one decimal place.

Date:  Edits the assignment or stand-alone category date.

Note:    The date is used in determining “in-progress grades” and
for inclusion on reports.

Note:    JMC recommends that you use dates with all your
assignments.

Weight:  Only editable when using User-Defined weights.

Note:    Weight of assignment towards the calculation of the
category average.

Attaching an Assignment to a Benchmark
An assignment may be attached to a benchmark for the purpose of calculating a
benchmark result.  More than one assignment may be attached to a benchmark.
Weighting of multiple assignments in a benchmark calculation may be edited on the
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Standards and Benchmarks screen in the Scores menu.

To attach an assignment to a benchmark:
1. Click on the assignment in the list on the left side of the screen to highlight it.

The page will appear similar to Figure 44.

Figure 44: Editing an Assignment

2. Click Select Benchmark.

Note:    You may need to perform an Office To Teacher from the file menu to
download local up-to-date copies of the standards and benchmark definitions in
your Online Teacher data.

3. Select the appropriate Standard from the menu, then select the appropriate
benchmark by either double-clicking it or by highlighting it and then clicking
OK.

Note:    To remove/unattach an assignment from a benchmark, follow the same
steps listed but select the “No Benchmark” option at step 3.

Quick Links

How To:
Add a Category – instructional video
Add an Assignment– instructional video
Delete an Category – instructional video
Do Extra Credit - Points – instructional video
Do Extra Credit - Weights Options 1 & 2 – instructional video
Do Extra Credit - Weights Option 3 – instructional video

Import Categories, Assignments, and Scores from current year    To import
categories, assignments, and scores from current year, click on this Quick Link.  The
page will appear similar to Figure 45.  Select the source course on the left side and the
destination course on the right side and click Import.
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Figure 45: Importing Categories, Assignments, and Scores from a Current Year Course

Scores - Standards and Benchmarks
This option is used to weight assignments within a benchmark and also to weight
benchmarks within a standard for calculation purposes. Select the Standards and
Benchmarks option under the Scores menu.  The screen will display the assignmnents
that are attached to each benchmark for a standard and course.  This section is used for
weighting the assignments that are attached to benchmarks and also to weight
benchmarks within a standard.

Figure 46:  Standards and Benchmarks screen – setting weights.

The overall weighting of assignments within a benchmark may be equally weighted, by
total points, or user defined.

1. If Equal is selected, all assignments will be weighted equally, e.g. 4
assignments each weighted 25%.
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2. If By Points is selected, all calculations are based simply on the number of
points.

3. If User Defined is selected, you may edit the weights for each assignment as
you see fit.  Click on each assignment to edit their respective weights.

The overall weighting of a standard is by weights only.  The weight of each benchmark in
the standards result calculation may be set by highlighting the benchmark in the list at the
left side of the Standards and Benchmarks screen and entering the desired weight in the
Weight box in the middle of the screen.  By default all benchmarks are weighted equally
for a standard.

Scores - Grade Cutoffs
This option is used to define the cutoffs for grades (e.g. “A” = 95—100%).  A set of
grade cutoffs should be defined for each class each marking period.  Student grades
cannot be calculated until cutoffs have been defined for the class.  The grades used must
be defined in the office.

1. Select Grade Cutoffs under the Scores menu.   The page will appear similar to
Figure 47.

2. Select a course section from the Course menu.

3. Starting at the top of the list, enter the highest grade given (e.g. “A”) in the left
column and the lowest percentage needed to achieve that grade (e.g. “95”) in the
right column.

4. Continue to enter the rest of the possible grades followed by the percentage
needed to achieve that grade.  You may either edit an existing row by clicking the
Edit link for that row, delete an existing row by clicking the Delete link for that
row, or add an additional row by clicking the Add Grade Cutoff link.

IMPORTANT:  Your last grade and percentage should be a failing grade with a
percentage of zero (“F” = “0”).

Figure 47:

Grade Cutoffs
page



JMC Online Teacher Documentation Page 66 of 80 Last update on 8/26/15

 
 Click on Copy… to duplicate the current grade cutoffs to other classes.

1. Select the classes to receive the current grade cutoffs.

2. Clicking on a class places a checkmark next to the class.  Checkmarked
classes will receive the current grade cutoffs.

Scores - Convert Missing to Zero
This option is used to convert missing scores to zeros.  This option may be useful at the
end of a term or other deadline when make-up work will no longer be accepted.

A missing score on the Assignment Scores screen is designated by a dot or period.
Missing scores do not affect calculated grades, but zero grades do.

To convert missing scores to zero:

1. Select Convert Missing To Zero from the Scores menu.  A screen will
appear similar to Figure 48.

Figure 48: Specifying the Cutoff Date for Converting Missing Scores to Zero

2. Enter the cutoff date in the Date box and click Execute.
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Reports - Progress Report
This option is used to prepare student progress reports.

1. Select Progress Report under the Reports menu.

2. Name the file to be saved. The page will appear similar to Figure 49.

3. Enter the desired date in the Report Date field.

Note:  Student grades will be calculated as of the date entered in the Report
Date field.

4. Select the course/period/term you wish to prepare.

5. Once the report date is set, information for each student may be entered.
To edit the information:

1. Select the student’s name in the list.
2. Click on the comment(s) that should be printed for the selected

student.
3. Click on the Choose link to the right of the student.

Note:  The list of comments is Teacher-defined.  You may edit the master list (See
Reports—Edit Comments).    Up to 254 characters of additional comments may
be hand-entered in the Additional Comments field to be printed on the progress
report.

6. To mark a student to be printed, check the box to the left of the the student’s
name.  Only students with a check next to their name will be printed.

Figure 49:

Progress
Report Setup
page
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- To mark all students to be printed, click the Select All button
- To include students above or below a certain percentage, use the

corresponding check box.

Note:    If the Include Present Grade For Each Student box is checked, each
student’s current percentage and grade will be printed.

Note:    If the Include Score Summary For Each Student box is checked, the
progress report will include a student summary for each student selected.  (See
Reports—Student Summary)

Calculate     The Calculate button will recalculate all of the students grade and
percentage according to the date in the Report Date field.  This needs to be done if the
Report Date is different than today’s date.

Preview     To preview the report click Preview.

Print    Click the Print button to print the previewed report.

Save Report    To save a report you must click the Save Report button. When a report is
saved you will be able to choose a previously saved report or create a new report.

Email Report     This option may be used to email progress reports (where possible)
instead of printing them.

Note:    In order for progress reports to be emailed, the students’ primary contacts
must have at least one email address entered if the primary contact is checked for In
Mailings and In Reports on Edit – Student Data in the Office Application.  If the
primary contact has multiple email addresses then the form would be received at each
email address.

To Office     To send progress reports to the office so they can be printed in the office,
click the To Office button.

Note: You must click Save Report and then click Preview before you are able to
send reports to the office.

Note:    You may create as many differently named progress report setup files as you
wish.  These files will remain where saved until you delete them.
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Reports - Edit Comments
This option is used to edit the master list of 64 standard comments used on student
progress reports.

Select Edit Comments under the Reports menu.
To edit a comment:

1. Click on the comment and type a new comment.

2. Use the <Enter> or <down arrow> key to move down the list and the <up
arrow> key to move up the list.

- To save changes, click the Update button.

- To print a list of the current comments, click the Print button.

Note:     Any changes made to the comment list will also appear when printing
any existing progress report files.

Reports - Missing Scores
This option is used to find all students who are missing one or more assignment scores.
The report checks all assignments with dates on or before a given date in the selected
term. The report will include assignments marked as late.

1. Select Missing Scores under the Reports menu.

Note:    The screen defaults to the current term selected.

Note:     To run a report for another term, exit the Missing Scores screen and
select the desired term under the Term menu.

2. Enter the desired date in the date box.

Note:     To check assignments with no dates, clear the date box and continue.

3. Choose either the student name option or the student number option (for
anonymity).

4. Click the Print Extra Message checkbox to print a one-line message with each
student.  Type the message in the message field.  (e.g.  “All make-up work due
June 1.”)

5. Click OK.

Note:     The report will print the assignment names and dates of missing
scores for each student.  If a student is not missing any scores, he/she will not
print on the Missing Scores Report.
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Reports - Student Summary
This option is used to print a breakdown of all assignment scores by student.  The report
will print a one-two page summary per student for the selected course/period/term.

1. Select the Student Summary option under the Reports menu.

2. Select the desired course/period/term.

3. To select a student, click on the student’s name in the list.  To deselect a student,
click again.

Note:     To print all students, click Print All.  To print no students, click
Print None.

- For each student selected, a summary will be printed with the current grade and
percentage along with a score and percentage by category and assignment.

Note:     A “.” appears when a score is missing.  An “X” appears when the
student is exempt from the assignment.

Note:     If an assignment has been dropped due to a low score, a note will
print next to the score.  (See # of low scores dropped in Score—Categories
and Assignments)

Reports - Assignment Summary
This option is used to print student scores and percentages for particular assignments in
the selected course/period/term. The class mean, median, maximum and minimum print
at the end of the report.
  

1. Select Assignment Summary from the Reports menu.

2. Select the desired course/period/term.

3. Choose either print student name or student number.

4. Select the desired category or assignment by clicking on the category/assignment.

Note:    A “.” denotes a missing score.  An “X” denotes an exempt score.

Note:    If a score was dropped due to a low score, a note will print next to the
score.
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Reports - Grade Summary
This option is used to print the marking period grade and percentage for each student in
the selected course/period/term. The class mean, median, maximum and minimum print
at the end of the report.

1. Select Grade Summary from the Reports menu.

2. Select the desired course/period/term.

3. Enter the desired date in the date field box.

Note:  The report will calculate a grade using assignments on or before the
date entered.

Note:  A note will be printed for missing scores on or before the date entered.

Reports - Scores Grid
This option is used to print student scores in a gradebook page format with assignments
across the top of the page and student names/numbers down the left-hand side.

1. Select Scores Grid from the Reports menu.

2. Select the desired course/period/term from the pop-up menu.

3. Enter the desired date in the date box.

Note:  Only assignments on or before the date entered will be printed.

4. Choose either student name or student number to print on the report.

Reports - Class Assignments
This option is used to print the categories and assignments for the selected class(es).  It
includes the weight, points possible, and date of each assignment.

1. Select Class Assignments from the Reports menu.

2. To select a class, click on the class name in the list.  To deselect a class, click
again.

Note:  To print all classes, click Print All.  To print no classes, click Print
None

Reports - Blank Score Sheets
This option is used to produce a grid with student names for the selected class.  The blank
grid is useful for entering assignment scores for later entry into your Online Teacher.
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Reports - Student Name and Number List
This option is used to produce a list of student names and numbers for reference when
using print-outs that only include one or the other.

Reports - Student Assessment Summary
This option is used to print a breakdown of all Standards and Benchmarks assessments by
student.  The report will print a one-two page summary per student for the selected
course/period/term, subject area(s), and standard(s).

1. Select the Student Assessment Summary option under the Reports menu.

2. Select the desired course or grade, subject area(s), and standard(s).

3. To select a student, click on the student’s name in the list.  To deselect a student,
click again.

Note:     To select all students, click Select All.

4. For each student selected, a summary will be printed with the current grade and
percentage along with a score and percentage by category and assignment, similar
to Figure 51.

Figure 50:

Student
Assessment
Summary Report
criteria screen.
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Figure 51: Sample Printout for Student Assessment Summary Report

Note:     A standard result may be incalculable if there are benchmarks for that
standard for which no benchmark result can be calculated for the day the
report is being generated.

Note:     A benchmark result may be incalculable if there are assignment
scores for the attached assignments.
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Reports – Student Standardized Tests Query
This option is used to produce a list of student names and their score(s) for a standardized
test.

1. Select Student Standardized Tests Queryfrom the Reports menu.  The page will
appear similar to Figure 52.

2. Select the desired option from the Course menu.

3. Specify the students from the selected course for whom you wish to view test scores.
You may click the Select All checkbox or you may Ctrl-click to select specific
students from the class list.

Test Category    By default you would get all test records from all test categories.  You
may select a specific test category from the Test Category menu.

Test/Subtest By default you would get all test records from all tests and subtests within a
test category.  If you have selected a specific test category then you may select a specific
test or subtest from the test category in Test menu.

Grade Levels When Test Taken   By default the grade level range for this report is set
to 0-12.  These grade levels represent the grade level for the student at the time the test
was taken, as specified in the Grade field of the test record itself.  If you wish to specify a
range other than 0-12 you may do so by editing the grade level menus.

Scores    By default this report will include any score (At Least 0.00 is selected).  To
include only scores above a certain cutoff you may edit the cutoff score.  To include only

Figure 52:
Student
Standardized
Test List
page
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scores in a certain score range you may select the Interval option and then specify the
high and low score for the interval.

Tests to Query    By default you would get All test records.  In some case students may
have more than one test record for the specified test category, subtest…  In these cases,
you may select either Best or Most Recent if you prefer to only display one test record
instead of all of them.

View    By default you would get a list view of the report similar to Figure 54.  You may
also specify a form view, which will have greater detail but will require more than one
line for each record.

Classroom Attendance – Enter Attendance
This option is used to enter attendance for a class.

1. Select Enter Attendance from the Classroom Attendance menu.  The page will
appear similar to Figure 53.

Figure 53: Entering Classroom Attendance

2. Select the appropriate day and course from the drop down lists at the top of the page.

3. For students that are absent or tardy, click in the appropriate option and reason (if
known).  If all students are present for that day/course/period then you may click on
the Attendance is correct button in the upper right corner of the page.
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Classroom Attendance – Edit Lunch Count
This option is used to edit lunch counts for a day.

1. Select Edit Lunch Count from the Classroom Attendance menu.  The page will
appear similar to Figure 54.

2. Select the appropriate day from the Day drop down list.

3. Enter the lunch count(s) in the appropriate box on the right side of the page and click
the Save button.

Note:    The names of the lunch counts as well as the number of lunch counts may
be edited at File – Online Settings in the Teacher tab.

Classroom Attendance – Reports – For A Student
This option is used to view attendance information for a student.

1. Select Reports – For a Student from the Classroom Attendance menu.  The
page will appear similar to Figure 55.

2. Specify the date range by choosing from the Day From and Day To lists, then click
the Preview button to see the report.  Click the Print button if you wish to get a
printout.

Figure 55:

Attendance
Report for a
Student

Figure 54:

Editing Lunch
Counts
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Classroom Attendance –Report – For A Period
This option is used to view attendance information for a period.

1. Select Report – For a Period from the Classroom Attendance menu.  The page will
appear similar to Figure 56.

2. Select the appropriate course from the drop down lists at the top of the page.

3. Specify the date range by choosing from the Day From and Day To lists, then click
the Preview button to see the report.  Click the Print button if you wish to get a
printout.

Classroom Attendance –Report – For A Day
This option is used to view attendance information for a day.

1. Select Report – For a Day from the Classroom Attendance menu.  The page will
appear similar to Figure 57.

2. Specify the day in the drop down list at the top of the page.

Figure 57:

Attendance
Report for a
Period

Figure 56:

Attendance
Report for a
Period
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All Students    To show all students in the school (not just those in the teacher’s classes),
click the All Student check box.

Sort By Grade    To sort the list by grade then student name, click on the Sort By Grade
check box.

Print    To print the displayed report, click on the Print button.

Homeroom – View Student Progress
This option is used to view progress reports for homeroom students.

1. Select View Student Progress from the Homeroom menu.  The page will appear
similar to Figure 58.

Figure 58: Viewing Student Progress for Homeroom Students

2. Enter the name of the student in the drop down list in the upper left corner.

All Students    To show all students in the school (not just those in the teacher’s
classes), click the All Student check box.

3. To view a specific progress report for a student click on the appropriate link for that
term.

Homeroom – Missing Scores
This option is used to display missing scores for homeroom students.

1. Select Missing Scores from the Homeroom menu.  The page will appear similar to
Figure 59.
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All Students    To show all students in the school (not just those in the teacher’s
classes), click the All Student check box.

2. Specify the type of report you want by selecting either All Missing Scores or Only
‘M’ and ‘MI’ Scores.

Figure 59: Missing Scores for Homeroom Students

Print    To print the displayed report, click on the Print button.

Homeroom – Student Contact Info
This option is used to dislay contact information for homeroom students.

1. Select Student Contact Info from the Homeroom menu.  The page will appear
similar to Figure 60.

2. Enter the name of the student in the drop down list in the upper left corner.

Figure 60:

Contact Info
for
Homeroom
Students
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All Students    To show all students in the school (not just those in the teacher’s classes),
click the All Student check box.

Print    To print the displayed report, click on the Print button.


